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INTRODUCTION
BM is a thin, dense and highly cross-linked form of extracel-
lular matrix (ECM) that underlies epithelia and endothelia, and 
surrounds muscle, nerve and fat cells1,2. This sheet-like network 
functions partly as a barrier to the movement of cells across tissue 
boundaries. During normal development and immune surveil-
lance, however, specialized cells acquire the ability to transmigrate 
through the BM as they disperse and subsequently form organs 
or respond to injury or infection3–5. Cancer cells are thought to 
highjack normal programs for BM transmigration as they spread 
from a primary tumor and colonize distant sites3,4,6. Despite its 
central role in cancer lethality, cell invasion through the BM 
remains one of the least understood steps in cancer progression7. 
Most BM transmigrations are difficult to visualize, because they 
are dynamic and unpredictable, and they often occur deep within 
tissues6,8. Hence, research on cell invasion has almost exclusively 
used in vitro and ex vivo tissue culture models. Although these 
model systems have revealed potential molecular mechanisms 
that govern cell invasion9,10, the complex milieu of extracellular 
signals and biochemical and biophysical cell–cell and cell–matrix 
interactions in vivo cannot be recapitulated outside the normal 
physiological environment4. Thus, understanding of BM trans-
migration remains incomplete.

C. elegans is a well-established model organism with a com-
pact genome that is well suited for high-throughput genetic  
and functional genomic studies11. In addition, the worm’s  
transparency facilitates real-time visualization of many biological 
processes that are otherwise experimentally inaccessible in com-
plex vertebrate tissues6,12. The anchor cell (AC) is a specialized 
type of uterine cell that invades through the BM and connects 
the uterine and vulval tissues during hermaphrodite develop-
ment13,14. These two tissues begin development juxtaposed but 

separated by the BM that lines each tissue. AC invasion initiates 
the connection of the uterine and vulval tissues, and this connec-
tion is required for mating and egg-laying in adult animals. The 
highly invariant nature of AC invasion, the ability to visualize the 
AC–BM interface, the ease of identifying genetic mutants and 
conducting RNA-interference screens and the robust transgenic 
approaches available for C. elegans make AC–BM transmigra-
tion a uniquely powerful model to study cell invasion in vivo. 
Importantly, AC invasion shares many of the same molecular and 
cellular mechanisms identified to regulate cancer-cell invasion, 
thus making it a relevant model to uncover conserved invasion  
programs affecting human health15–20. In this protocol, we  
provide detailed information about how to image C. elegans 
AC–BM transmigration.

Comparison with other models
In vivo, cell invasion through the BM occurs in complex and 
dynamic cellular microenvironments in which the invasive proc-
ess is influenced by the mechanical properties and chemical cues 
of surrounding tissues. In addition, BMs comprise more than  
100 different proteins, glycoproteins and proteoglycans, thus 
making full recapitulation of BM invasion difficult through 
2D cell culture and 3D matrix models1,21–23. Because BM can-
not be synthesized in vitro, many techniques for examining cell 
invasion rely on assays in which cultured cells are placed on or 
within a simplified matrix (e.g., gelatin or collagen), reconstituted 
BM (Matrigel), denuded BM explants or chick chorioallantoic 
membranes10,24–26. New microfluidic platforms allow for real-
time imaging of human cancer-cell extravasation at single-cell 
resolution within in vitro microvascular networks27. This assay  
substantially recapitulates an important step in cancer metastasis,  
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but BMs crossed during extravasation can be visualized only  
statically through immunofluorescence approaches using  
antibodies after tissue fixation. These genetically and visually 
accessible models have been effective in allowing the identifica-
tion of key pathways and cellular processes governing invasion. 
However, because these in vitro invasion assays cannot recapitu-
late endogenous BM matrices or the native tissue environment, 
the physiological relevance of findings from these systems remains 
uncertain. Further, these models cannot reveal mechanisms that 
manifest only in complex in vivo environments.

Several in vivo models have been developed in a variety of model 
organisms to study BM invasion in varying contexts4. Polarization 
of the anterior–posterior axis during mouse embryogenesis28 and 
the process of epithelial-to-mesenchymal transition during chick 
gastrulation29,30 are both similar to AC invasion in C. elegans in 
that they capture BM breaching during a predictable time point 
in animal development. However, BM visualization in both these 
models requires immunohistochemical analysis of fixed tissues 
by using antibodies to collagen IV or laminin, because fluores-
cently tagged BM markers have not been developed. Drosophila 
imaginal-disc eversion is a well-studied developmental event that 
requires BM degradation at a specific stage in larval animals31,32. 
Importantly, in Drosophila, as in C. elegans, BM proteins includ-
ing collagen IV have been successfully tagged with fluorescent 
proteins33,34, but live-cell imaging of cell–BM interactions during 
disc eversion have not yet been successfully captured31. Drosophila 
tissue is highly pigmented, thus making live-cell imaging deep 
within tissue more complex than imaging within transparent  
C. elegans35. Zebrafish xenographs36,37 and intravital imaging in 
mice38,39 have been used to examine the movements of trans-
formed cells within and through blood vessels, which are essential 
steps in cancer-cell metastasis. Through recent advances includ-
ing the use of an imaging window38 in mice and pigmentation 
mutants in zebrafish40, these models have overcome the problem of 
visual inaccessibility of live imaging of events deep within tissues. 
However, BM cannot be directly visualized in either of these con-
texts, and fluorescent proteins marking the vasculature are used to 
infer BM crossing in real time. Direct visualization of BM in these 
systems also requires tissue fixation for antibody-based detection. 
Overall, these models share several strengths and have some simi-
larities to AC invasion in C. elegans. However, they have not yet 
allowed for the live-cell imaging approaches needed to capture the 
dynamic events at the cell–BM interface during invasion.

Microfluidic technology is an alternative approach for imag-
ing AC invasion in its entirety41,42. In particular, a recent device in 
which worms are gently immobilized by flow, and a gradual increase 
in pressure43 allows for imaging with high temporal resolution for 
extended durations. The downsides to microfluidic approaches are 
the complexity and cost of the systems. Further, these microfluidic 
techniques do not allow for easy manipulation of the orientation of 
animals, an ability that we have found to be helpful in visualizing AC 
invasion both laterally and ventrally. Finally, AC invasion is com-
pleted over a 2-h time window during which viability is not affected 
by anesthetic immobilization44; thus, microfluidic approaches are 
not necessary for optimal immobilization for imaging.

Development of the protocol
Here, we present a detailed protocol for using time-lapse micro-
scopy and quantitative 4D image analysis to study AC invasion  

in C. elegans. Through our studies using this protocol, we have 
found that AC invasion can be divided into distinct cellular 
processes19,20,45–47 (Supplementary Fig. 1, Supplementary 
Table 1 and Supplementary Video 1). Beginning approximately 
6 h before invasion, a number of proinvasive genes that regu-
late actin dynamics and BM composition are expressed, and the 
encoded proteins polarize to the AC invasive cell membrane, the 
cell membrane at the AC–BM interface15,18,48. Shortly thereafter 
(~1 h), dynamic F-actin-based AC invadopodia form, depress the 
BM and then break down48. Each invadopodium has a lifetime 
of ~1 min. Triggered by a precisely timed secreted signal from 
the vulval cells, one or two invadopodia breach the BM during a 
narrow 30-min window in the mid-L3 larval stage15. The inva-
dopodium that breaches the BM transforms into a large cellular 
protrusion that advances through a single hole in the underlying 
BM. As the protrusion enlarges, the BM is partially degraded and 
pushed aside as the protrusion extends between the underlying 
centrally located 1° fated vulval precursor cells (1° VPCs)19,49 
(Supplementary Video 2). Taking advantage of the stereotyped 
nature and visual accessibility of AC invasion, we have devel-
oped a time-lapse technique that allows for convenient imaging of  
the entire AC invasion process, which is normally completed 
within 2 h48. This model offers a unique opportunity to simulta-
neously examine dynamic events within the invading cell and in 
the BM being traversed.

Applications of the protocol
The imaging protocol described here can be used to study the 
entire process of cell invasion through BM—from initial polari-
zation of the invasive cellular machinery toward the BM to the 
formation of F-actin-based invadopodia, to the initial breach, to 
the formation of the invasive protrusion and to the modification, 
degradation and physical displacement of the BM. By using geneti-
cally encoded fluorescent proteins fused to the protein(s) of inter-
est50–52, dual-color or multicolor imaging can be performed. This 
procedure allows for simultaneous monitoring of two or more 
transgenes to uncover the dynamic interplay between the invading 
cell and the BM in real time. Alternatively, multiple proteins within 
the BM or the AC (often driven by AC-specific promoters (denoted 
with ‘>’), such as cdh-3>53, zmp-1>54, inft-1>55,56 and lin-29>57,58) 
can be viewed simultaneously to uncover genetic interactions, sites 
of action or possible colocalization between fluorophores15,47–49. 
Photodynamic imaging techniques, such as fluorescence recovery 
after photobleaching59 and fluorescence loss in photobleaching60, 
can also be implemented to assess cellular or BM dynamics during 
AC invasion16,18,49,57. Fluorescent activity probes for molecules 
such as the Rho GTPase can also be used15. Beyond common fluo-
rescent proteins, proteins with unique properties, such as photo-
convertible fluorescent proteins, are particularly useful for tracking 
molecules of interest over time18,46,48. For instance, Dendra is a 
photoconvertible fluorescent protein that fluoresces green as GFP 
does but fluoresces red after brief exposure to 405-nm light61. By 
fusing Dendra to laminin, a major component of the BM, we have 
tracked BM fate and have found that physical displacement of the 
BM contributes to its removal during AC invasion48. Imaging tech-
niques that have been implemented by our laboratory by adapting 
this protocol are summarized in Table 1.

Variations of this protocol can also be used to investigate the 
interactions between the AC and neighboring cells that constitute 
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Table 1 | Examples of 4D live-cell imaging used to quantify invasion dynamicsa.

Description of experiment Timing Markers Mutant/RNAi/Txb References

BM-associated proteins

BM-hole expansion 60- to 90-min TL, 
2-min int

Laminin (LAM-1::GFP) WT, unc-40 (DCC) and him-4 
(hemicentin) mutants

 48,49

Hemicentin dynamics before  
and during AC invasion

1-h TL, 60-s int Hemicentin (GFP::HIM-4); 
Actin (mCh::moeABP)

WT  49

FRAP analysis 

Dystroglycan and integrin  
membrane-recovery rates

9-min TL,  
30-s int

Dystroglycan (DGN-1::GFP); 
Integrin (PAT-3::GFP)

WT and lin-29 (EGFR)  
mutants

 57

Measuring BM collagen turnover SS at 0 h and 3 h Collagen (EMB-9::mCh) ost-1 (SPARC) overexpression  16

Landmark photobleaching 

Tissue shifting performed after  
photobleaching to measure  
BM linkage

SS before and  
after shifting

Laminin (LAM-1::GFP) WT and him-4 (hemicentin) 
mutants

 39

Photoconversion 

BM sliding measured after optical  
highlighting

SS at 0 h and 
3–4 h

Photoconvertable laminin 
(LAM-1::Dendra); type-IV 
collagen (EMB-9::Dendra)

WT worms at different  
larval stages

 46

BM photoconverted before and after 
invasion to determine BM physical  
displacement

SS at 0 h and 
2–3 h

Photoconvertable laminin 
(LAM-1::Dendra); type-IV 
collagen (EMB-9::Dendra)

WT and unc-40 (DCC) mutants  48

AC proteins

Invadopodia size, lifetime, number  
and rate of formation

24- to 60-min TL, 
15- to 60-s int

F-actin (mCh::moeABD) WT, cdc-42 (Cdc42), lin-3 
(EGF) and gdi-1 (GDI) RNAi

 48,18,15

Imaging the transition from  
invadopodium to invasive protrusion

1-h TL, 60-s int PI(4,5)P2 (mCh::PLCδPH); 
Laminin (LAM-1::GFP)

WT  48

AC invadopodial membrane trafficking 
and recycling from the endolysosome 
to the plasma membrane

40-min TL, 60-s 
int

PI(4,5)P2 (mCh::PLCδPH); 
Laminin (LAM-1::GFP)

WT, unc-60 (ADF/cofilin),  
cdc-42 (Cdc42), lin-3 (EGF) 
and gdi-1 (GDI) RNAi

 18,15

Time lapse showing cell-division  
activity during AC invasion

1-h TL, 30-s int F-actin (mCh::moeABD);  
histone H2B (H2B::GFP)

nhr-67/tlx (NR2E) RNAi  55

Oscillating F-actin-clustering  
behavior

1-h TL, 60-s int F-actin (mCh::moeABD) WT, unc-6 (netrin), unc-40 
(DCC) and madd-2 (TRIM) 
mutants

 47

Colocalization experiments with  
F-actin and DCC (netrin receptor)

1-h TL, 60-s int DCC (UNC-40::GFP);  
F-actin (mCh::moeABD)

WT  48,47

Protein enrichment at BM  
breach sites

60-min TL,  
15- to 120-s int

F-actin (mCh::moeABD); 
laminin (LAM-1::GFP);  
DCC (UNC-40::GFP)

WT, unc-40 (DCC) mutants  48

Photoconversion 

Optical highlighting to measure  
actin disassembly at invadopodia

SS at 0 h,  
postconversion 
and 30 min

Photoconvertable actin 
(Dendra2::ACT-1)

unc-60 (ADF/cofilin) RNAi  18

Optical highlighting to lineage AC fate SS at 0 h and 
6–8 h

Histone (H2B::Dendra) nhr-67/tlx (NR2E) RNAi  55

(continued)
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the invasive microenvironment, such as the neighboring ventral 
uterine cells (to which the AC remains adherent during invasion) 
and the vulval cells into which the AC invades15,57. Finally, the 
applications of this protocol are not limited to the study of AC 
invasion and could be applied, for example, to studying mem-
brane trafficking during neurite outgrowth62 or real-time analysis 
of the turnover, repair and aging of the ECM16,46,57,63,64.

Recent upgrades to our imaging system have allowed for 4D 
time-lapse acquisition of several animals simultaneously. We 
use Micro-manager software (https://micro-manager.org/) 
to run an MS-2000 XYZ automated stage (Applied Scientific 
Instrumentation) through the Multiple Position (xy) option  
in the Multi-dimension Acquisition control dialog. Using the  
automated stage, we have imaged up to six worms in parallel,  
thus substantially decreasing the overall imaging time needed to 
collect time-lapse images from multiple animals.

Limitations of the protocol
There are technical and temporal limitations that preclude  
continuous imaging for some experiments. For example, we have 
used Dendra fused to laminin to determine BM removal over the 
course of AC invasion (described above). Converted (red) Dendra 
photobleaches rapidly, thus making continuous imaging prohibi-
tive. In addition, the 2-h to 3-h time window necessary to pho-
toconvert and then follow BM displacement during AC invasion 
exceeds the duration during which healthy animals anesthetized 
on coverslips can be successfully imaged, because they may enter 
a starvation-arrest state63. To circumvent these limitations, we 
take initial (t = 0) snapshots directly after photoconversion and 
then carefully recover worms from coverslips and place them back 
on agar plates with food. The worms are then mounted on slides 
again for postinvasion imaging 2 h to 3 h later. We have success-
fully used this approach for several experiments involving optical 
highlighting or photobleaching (Table 1).

Procedure overview and experimental design
In this protocol, we outline methods for 4D imaging and analysis 
of AC invasion in live worms. Different parts of the procedure 
explain the synchronization of larval growth (Steps 1–4), mount-
ing worms for time-lapse imaging (Steps 5–10), microscope 
parameters used for optimal resolution (Steps 11–16), process-
ing of image files necessary for vibrant movies (Steps 17–24) and 

examination of the resulting data to obtain quantitative measure-
ments of several aspects of cell invasion (Steps 25–27) (Fig. 1). 
The transgenic strains that are commonly used for studies of AC 
invasion are listed in Supplementary Table 2. Although the fol-
lowing methods are for imaging AC invasion during the L3 larval 
stage, we anticipate that this protocol will be useful to C. elegans 
researchers who wish to use live-cell imaging in various tissues 
during any larval or adult stage. Because these methods can be 
adapted for use with a number of different imaging systems and 
software, we use general descriptions throughout the protocol.

Worm preparation before time-lapse imaging (Steps 1–10).  
Figure 2 and Supplementary Video 3 show an overview of the  
materials and workspace setup. The 0.5-h to 2-h continuous imag-
ing needed to capture aspects of AC invasion requires the worms 
to be immobilized. Our immobilization technique is adapted from 
methods developed by Knobel et al.65 (Steps 5–7). Tricaine (0.2% 
(wt/vol)) combined with 0.02% (wt/vol) levamisole in M9 buffer 
is used to anesthetize worms at the early- to mid-L3 larval stage 

Table 1 | Examples of 4D live-cell imaging used to quantify invasion dynamicsa (continued).

Description of experiment Timing Markers Mutant/RNAi/Txb References

FLIP

Photobleaching experiments showing 
recycling through the endolysosome at 
the invadopodial membrane

10-min TL,  
30-s int

LAMP-1 (LMP-1::GFP) unc-60 (ADF/cofilin) RNAi  18

AC interaction with neighboring cells

Ectopic membrane-tethered-netrin 
attraction assay

1-h TL,  
1-min int

Netrin (UNC-6::NLG-1  
TM::GFP); F-actin  
(mCh::moeABD)

unc-40 (DCC) mutants  47

aTx, treatment; WT, wild type; int, interval; TL, time lapse; SS, snapshot; RNAi, RNA interference. bThe vertebrate-ortholog-encoded protein is listed in parentheses.

Steps 5–10 

Steps 17–24 

Steps 11–16 20 min–3 h

20 min

20 min 

Invasive 
protrusion volume

Invadopodium 
number, size
 and turnover

BM-
removal

rates

Step 27 
Step 26

Step 25

Variable

Steps 1–4 15 min

Developmentally 
synchronize worms

Mount anesthetized
worms to slides 

4D confocal imaging 

Import and process images in Imaris

Analyze invasion dynamics

Figure 1 | Overview of the protocol. Steps are shown in purple, and the 
anticipated times to complete each step are shown in green.

https://micro-manager.org/
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(Supplementary Table 1). A 12-min incubation of the worms in this 
anesthetic solution in a three-well glass slide (Fig. 3a,c) is sufficient 
to immobilize worms for 2 h (if they are mounted/maintained in 
the solution). It is important to maintain the worms on the slide 
in M9 liquid but also to allow for gas exchange during imaging. 
To accomplish this, a glass slide is used with an agar pad on which 
anesthetized worms are dispersed (Fig. 3b,d,e). A coverslip is then 
placed on top of the worms, and a Vaseline, lanolin and paraffin wax 
(VALAP) mixture is immediately applied66 (details in MATERIALS) 
to seal the edge of the coverslip and the underlying agar pad (Step 8). 
The VALAP helps to prevent evaporation. To allow for gas exchange, 
two small gaps are left along the sides of the coverslip (Fig. 3f).  
This approach consistently keeps worms alive for 2 h without nega-
tively affecting worm development. In our tests, approximately 
89% (17/19) of worms recovered from a 2-h time-lapse imaging  
session survived and continued to grow into adulthood and produce 
healthy progeny. Furthermore, we have found that invasion occurs 
at the same rate in mounted and anesthetized worms as those not 
mounted and anesthetized (n 40 animals observed). As an alternative 
to anesthetics, worms can be immobilized with polystyrene beads 
placed on 10% (wt/vol) agar pads67. However, we have compared 
beads with 5% (wt/vol) agar versus the tricaine and levamisole 
mixture and have found the tricaine and levamisole mixture to be 
superior for immobilization, possibly because worms move more 
during L3 than during adult or other larval stages68.

Given the short (~2 h) time window of AC invasion, we often 
synchronize worm growth to obtain a sufficient number of ani-
mals at the proper developmental stage (mid-L3 larval stage)69. 
To synchronize worms, four to six plates of gravid hermaphro-
dites are bleached, and their embryos are collected and washed. 
These embryos are allowed to hatch in M9 buffer without food 
(Escherichia coli, OP50), and starved worms arrest in the L1 larval 
stage. Worms can survive in this condition for ~10 d (ref. 70). 
After the arrested L1 worms are given food, they begin to recover 
from arrest within 1 h (ref. 71) and initiate growth in synchrony, 
and they are ready for imaging at the mid-L3 stage ~30 h later  
(at 20 °C; 40 h later at 15 °C). The detailed synchronization  
protocol can be found in PROCEDURE Steps 1–4.

Confocal imaging of AC invasion (Steps 11–16). For image 
acquisition, a commercially available or customized spinning-disk  

confocal microscope can be used (our microscope setups are 
shown in Fig. 4a). A scanning unit, high-power excitation lasers 
and a 100× objective with a high numerical aperture (NA) are 
essential for performing time lapse of AC invasion. We have used 
a laser scanning confocal microscope for imaging AC invasion to 
precisely photobleach or photoconvert fluorophores. However, 
because of rapid photobleaching, we have been successful at imag-
ing for only short time intervals, even when capturing a single 
plane. The high laser power of point illumination bleaches live 
samples more rapidly and more quickly than does the area illu-
mination of spinning-disk confocal microscopes. In addition, 
the time required for image acquisition is longer (approximately 
tenfold) on a scanning confocal microscope, because of the time 
required to complete the line scan for each imaging plane, thus 
limiting the number of z slices and the time intervals for acquisi-
tion (a time interval of several minutes is often required, whereas 
less than 10 s is required with a spinning-disk confocal micro-
scope). Because we have observed measurable changes in actin 
dynamics at invadopodia by using 15-s timed intervals, we have 
found the spinning disc to be optimal for this protocol.

To observe the entire process of AC invasion, worms at the 
early- to mid-L3 larval stage should be identified for imaging13. 

Small paintbrush

Guide slides for
pouring agar pad

Glass spot plate

5% noble agar VALAP

22 mm × 22 mm coverslips

Mouth pipette
Assembly

0.2% tricaine,
0.02% levamisole

Figure 2 | Tools and reagents for preparing larval-stage C. elegans for time-
lapse microscopy. Image shows basic tools and reagents used for standard 
worm maintenance and some of the additional equipment needed to prepare 
larval-stage worms for time-lapse microscopy.

a b

c d

e f

Figure 3 | Anesthetizing and mounting worms for time-lapse microscopy.  
(a) Collect worms of interest in one round of picking, and then gently  
swirl the pick in 50 µl of the anesthetic. Moving the pick in and out  
of the anesthetic will help to pull the worms off the pick. (b) Image shows 
an assembly for pouring agar pads, which consists of two guide slides  
(each with two pieces of laboratory tape) and two clean microscope slides. 
(c) After 12–15 min, the worms should exhibit minimal movement. Gentle 
tapping on the glass spot plate will cause the worms to coalesce at the 
bottom of the well, thus allowing them to be collected by mouth pipette 
in a minimum volume of liquid. (d) Next, separate the agar-pad-pouring 
assembly, and use a razor blade to cut the agar pad into a 22 × 22 mm 
square. (e) Dispel the collected worms onto the trimmed agar pad (they will 
remain in the anesthetic), and remove excess liquid anesthetic. (f) Place  
a 22 × 22 mm glass coverslip over the worms, and seal with VALAP.  
Leave two small gaps on opposite sides for gas exchange.
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Worm staging can be done by examining the number of divisions 
of the primary vulval cells, the degree of gonad-arm reflection and 
the number of ventral-uterine-cell descendants by using differen-
tiation interference contrast imaging (Supplementary Table 1).

Imaging parameters will need to be optimized according to the 
particular imaging experiment to maintain a balance between  
sufficient image quality and overall animal health, which can be 
negatively affected by phototoxicity and photobleaching. These 
adverse photoeffects are positively correlated with total exposure 
time, which in turn depends on the laser power, bin settings, gain, 
objective, number of sections per z stack, frequency of time intervals  
and number of fluorescence channels acquired. The settings that 
we have optimized for the imaging outlined in this protocol are 
listed in Step 11 and outlined in Supplementary Video 4. Using 
these parameters, we have not observed severe phototoxicity and 
photobleaching when performing single- or dual-color imaging. 
We use the electronic multiplication (EM) function of an electron- 
multiplying charge-coupled device (EM-CCD) camera, thus allowing  
for markedly shorter exposure time for fluorescent proteins and 
further minimizing phototoxicity and photobleaching. When 
analyzing data in which voxels are measured and quantified, it is 
important to use the same imaging settings for the same transgene 

across all genetic backgrounds examined, to ensure comparability. 
Because camera technology is developing rapidly, we anticipate that 
advanced imaging platforms will be available in the near future, 
thus allowing for increased speed and resolution.

Mounting and orienting worms for imaging (Steps 5–10). When 
placed on an agar pad, the worms naturally orient on their sides, 
thus conveniently allowing for AC invasion to be imaged from the 
lateral perspective (Fig. 4b, left). However, this imaging perspective 
is not optimal for capturing the entire range of invasion events that 
occur at the cell–BM interface. To observe the complete cell–BM 
interface, we have found it optimal to image worms in the ventral 
plane (Fig. 4b, right). To perform ventral imaging, roller mutants72 
such as rol-6(su1006) can be used by crossing the rol-6 mutation 
into the genetic backgrounds of the strains of interest. In our expe-
rience, 20% of rol-6(su1006) worms mounted on coverslips natu-
rally lie with the ventral surface turned toward the objective. Ventral 
imaging is particularly useful when examining invadopodia forma-
tion and turnover (Step 25) and BM-hole opening (Step 27).

Data analysis (Steps 17–27). Currently, there are a variety 
of programs available for acquiring time-lapse imaging data, 

Solid-state lasers

Stage 
piezo

Spinning-disc 
scan head

EM-CCD
camera

CCD camera

Support stand

b

Wild type, lateral view

rol-6(su1006)
Ventral view

a

AC–BM interface
lateral view

L–R axis

D–V axis
A–P axis

Confocal
slice

Confocal
slice

(Dorsal–ventral)
(Anterior–posterior)

(Left–right)

Confocal-imaging perspectives:

A
D

L
P

V

R

AC–BM interface
ventral view

Filter
wheel

Figure 4 | Hardware systems and imaging perspectives for time-lapse analysis of AC invasion. (a) Image shows two spinning-disk confocal microscopes 
equipped for time-lapse microscopy. Both setups have solid-state lasers and a motorized stage piezo. (b) Schematic diagram depicting the two imaging 
perspectives for time-lapse analysis of AC invasion. Worms normally lie on their sides (left), thus allowing for AC invasion to be imaged laterally (lateral view). 
In contrast, in the rol-6(su1006)-mutant background (right), ~20% of mounted worms orient with their ventral surface facing the objective. This orientation 
allows for confocal sections to be taken in the plane of the AC–BM interface. Scale bar, 5 µm (for left and right images). 
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many of which are included with commercially available confo-
cal systems, such as iQ3 (Andor), Metamorph (Olympus), Zen 
(Zeiss), Elements (Nikon) and iVision (BioVision), as well as 
open-source platforms, such as Micro-manager. For 4D data 
analysis after data acquisition, we use Imaris (Bitplane), a com-
mercially available software compatible with a wide range of 
raw data formats. Details regarding how to use Imaris to correct 
image drift caused by movement of animals during imaging and 
how to perform 4D image analysis of membrane protrusions  
and cytoskeletal structures can be found in Supplementary 
Videos 5–8. Imaris is specialized software designed for seamless 
import, visualization, manipulation and analysis of large 3D and 
4D data sets. Importantly, if access to Imaris is unavailable, sepa-
rate ImageJ plugins are available for 3D and 4D analysis, including  

drift correction, free rotation, spot tracking and volume meas-
urement. We have found that ImageJ (National Institutes of 
Health) is sufficient and optimal for handing 2D data sets such 
as those for BM-hole-opening rates. There are several steps 
during image analysis that require users to set intensity thresh-
olds for fluorescence signals (Steps 26 and 27) and manually 
edit computer-generated tracks when analyzing invadopodia 
lifetimes (Step 25). To minimize potential bias, we blind data 
sets with the freely available ImageJ macro ‘Randomizer.’ We 
recommend having two researchers independently analyze data 
sets through these approaches to confirm the results obtained. 
Using these approaches, we have achieved repeatable and robust 
results measuring invadopodia dynamics15,18,48,55 and BM clear-
ance rates48,49.

MATERIALS
REAGENTS
Maintenance of C. elegans

Transgenic worms expressing fluorescent-protein fusions (Table 1 and  
Supplementary Table 2). As an example, this protocol may use  
GFP-tagged laminin driven by its endogenous promoter (lam-1>  
LAM-1::GFP, denoted LAM-1::GFP), AC-specific markers for actin  
(cdh-3> mCherry::moeABD, denoted mCh::MoeABD), plasma-membrane 
phospholipids (e.g., phosphatidylinositol 4,5-bisphosphate (PI(4,5)P2)) or 
cdh-3> mCherry::PLCδPH, denoted mCh::PLCδPH); vital dyes can also be 
used ! CAUTION Any experiments involving live C. elegans must conform 
to relevant institutional and national regulations. Many strains are available 
through the Caenorhabditis Genetic Center (CGC; https://cgc.umn.edu/). 
Published strains that are not found in the CGC can be requested by  
contacting the corresponding author listed in a given manuscript.
Nematode growth medium (NGM) plates (detailed C. elegans culturing 
protocols in ref. 73)
E. coli strain OP50 ordered from the Caenorhabditis Genetic Center  
(https://cgc.umn.edu/)
Alkaline bleach solution
Autoclaved water

Anesthesia
Levamisole (Sigma, cat. no. 31742) ! CAUTION Levamisole is acutely toxic 
orally. Wear respiratory protection. Avoid dust formation. Avoid breathing 
vapors, mist or gas. Ensure adequate ventilation. Evacuate personnel to safe 
areas. Avoid breathing dust.
Tricaine (Sigma, cat. no. 886-86-2) ! CAUTION Tricaine causes skin, eye 
and respiratory irritation. It is harmful to aquatic life and has long-lasting 
effects. Avoid breathing dust, fumes, gas, mist, vapors or spray. Wash skin 
thoroughly after handling. Use only in a well-ventilated area, and avoid 
release to the environment.
M9 buffer (see Reagent Setup)

Mounting worms
Agar pad (noble agar; BD, cat. no. 214230) (see Reagent Setup)
VALAP (see Reagent Setup)

Microscopy
Immersion oil for microscope objective lens (type F)

EQUIPMENT
Mounting worms

Dissecting stereoscope (Zeiss, cat. no. STEMI 2000)
Three-well clear glass Pyrex micro spot plate (Sigma, cat. no. CLS722085)
Heat block set to ~70 °C
Standard microscope slides and coverslips (22 mm × 22 mm, no. 1.5)
Flame (Bunsen burner or ethanol flame)
P200 pipette and tips
Worm pick (platinum wire melted into the end of a cut glass  
Pasteur pipette)
Aspirator tube assembly (mouth pipette) (VWR, cat. no. 53507-278)
Pulled capillary glass pipettes (Kimble Kimax, cat. no. 34500 99)
Paintbrush for applying VALAP sealant (a smaller brush is easier to control)

•

•

•

•
•

•

•

•

•
•

•

•
•
•
•
•
•
•

•
•
•

Laboratory wipes
Razor blades

Microscopy
Spinning-disk confocal microscope. We prefer an upright setup, but an 
inverted microscope can also be used. Many variations of hardware and 
acquisition software exist, and different combinations can be assembled to 
work well. We use a Yokogawa CSU-10 (Yokogawa Electric Corporation, 
modified by Spectral Imaging) spinning-disc head mounted on an upright 
Zeiss AxioImager.A1
Objectives: 10× EC Plan-Neofluar 10×/0.3 M27 for locating worms and 
100× Plan-Apochromat 100×/1.40 oil Differentiation interference contrast 
microscope for imaging (Zeiss)
Solid-state lasers: Cyan 488 nm (CDRH) (Spectra-Physics); Cobolt Jive  
561 nm (CDRH, DPSS laser) (Cobolt)
Motorized Stage for z-stack acquisition: Piezo Z-axis Stage (Applied  
Scientific Instrumentation, cat. no. PZM-2000)
Camera: Orca-R2 (Hamamatsu, cat. no. C10600) or EM-CCD  
(Hamamatsu, cat. no. C10600-10B)
Filterwheel (Applied Scientific Instrumentation, cat. no. FW-1000)
Filters: ZET448/561 m, ZET405/448/561 m and ZET450/50 m (Chroma)
Stage micrometer

Image-processing software
ImageJ 1.40g (National Institutes of Health, https://imagej.nih.gov/ij/)
iVision image-acquisition software (Biovis, http://www.biovis.com/ 
ivision.htm)
Imaris (Bitplane) for confocal z-stack 4D reconstruction. Version number 
7.4 is shown in the video tutorials (Supplementary Videos 5–8), but steps 
in this protocol are consistent with the newer versions of the software  
(8.4 at the time of publication)

Additional materials
15-ml conical tubes
Benchtop centrifuge
Laboratory rocker
Laboratory tape

REAGENT SETUP
M9 buffer  Mix 6 g Na2HPO4, 3 g KH2PO4, 5 g NaCl and 1 ml of 1 M MgSO4, 
and adjust the volume to 1 l with water. Sterilize by autoclaving, and  
place aliquots into 100-ml bottles. Unopened stocks can be stored at room 
temperature (~20–25 °C) for 3 months.
Levamisole solution  Dissolve levamisole powder in water to prepare  
a 10 mM solution as a 10× stock, which can be stored at −20 °C for several 
years. Dilute the 10× stock with M9 buffer immediately before use to make  
a 1× working solution.
Anesthesia buffer  Dissolve the levamisole and tricaine powder in water to 
prepare 0.2% (wt/vol) levamisole and 2% (wt/vol) tricaine as the 10× stock. 
These stocks remain stable for several years at −20 °C. The 10× stock can be 
diluted with M9 immediately before use to make a 1× working solution that 
can be stored at room temperature (20 °C) for 1 week.

•
•

•

•

•

•

•

•
•
•

•
•

•

•
•
•
•

https://cgc.umn.edu/
https://cgc.umn.edu/
https://imagej.nih.gov/ij/
http://www.biovis.com/ivision.htm
http://www.biovis.com/ivision.htm


©
20

17
 M

ac
m

ill
an

 P
u

b
lis

h
er

s 
L

im
it

ed
, p

ar
t 

o
f 

S
p

ri
n

g
er

 N
at

u
re

. A
ll 

ri
g

h
ts

 r
es

er
ve

d
.

© 2017 Macmillan Publishers Limited, part of Springer Nature. All rights reserved.

protocol

2088 | VOL.12 NO.10 | 2017 | nature protocols

© 2017 Macmillan Publishers Limited, part of Springer Nature. All rights reserved.

VALAP  Combine equal amounts of Vaseline, lanolin and paraffin wax by 
weight. Heat over a hot plate and mix together. Prepare 1.5-ml aliquots 
and store them at room temperature (stocks will last indefinitely). Melt 
the aliquots before use by placing them in a heat block at ~70 °C.
Agar  Melt 5% (wt/vol) noble agar65 in a microwave, and then place aliquots 
of the solution into disposable glass culture tubes (VWR, cat. no. 47729-572) 
at a volume of 1.5 ml per tube and store the tubes at room temperature.  
We use plastic caps (Port City Diagnostics, cat. no. T3600CAP) to seal the 
tubes, thus allowing the agar to be stored for at least 2 months without  

drying out. Melt the agar aliquots over a Bunsen burner, and then place  
them in an ~70 °C heat block to keep the solution liquid.  CRITICAL The 
high percentage (5% (wt/vol)) of agar decreases z drift (the worms sinking 
into the agar over time).
EQUIPMENT SETUP
Confocal imaging system  Turn on the hardware and open the software 
components and set the proper parameters for time-lapse imaging, including 
exposure time, laser intensity, EM gain, binning, z-stack range and step size, 
time-lapse duration and time interval.

PROCEDURE
Synchronize worm cultures for imaging (optional) ● TIMING 15 min
 CRITICAL Performing synchronized L1 larval plating facilitates worm-picking efficacy using a dissecting stereoscope mi-
croscope at the developmental stage optimal for time-lapse imaging (e.g., when imaging AC invasion, use worms at mid- to 
late-L3 larval stage).
1 | Wash two or three NGM plates containing a large number of gravid hermaphrodites with 4 ml of water, and transfer  
the washed worms to a 15-ml conical tube.

2 | Centrifuge at 400g for 1 min in a benchtop centrifuge at 20 °C. Aspirate the supernatant and resuspend the settled 
worms in 4 ml of M9 buffer. Add 5 ml of alkaline bleach solution (made by mixing 2.3 ml of household bleach, 0.4 ml of 5 M 
KOH and 2.3 ml of autoclaved water). Shake the tube for 4–6 min in a rocker until worms are fully dissolved. Immediately  
centrifuge the tube at 400g for 1 min in the benchtop centrifuge.

3 | Aspirate the supernatant, and resuspend the pellet in autoclaved water by shaking the tube vigorously by hand 4–6 times,  
then centrifuge at 400g for 1 min in the benchtop centrifuge at 20 °C. Repeat this step twice.

4 | Aspirate the supernatant, and resuspend the pellet in M9 buffer by shaking the tube vigorously by hand 4–6 times.  
Centrifuge at 400g for 1 min at 20 °C. Aspirate the supernatant, and add 0.5–1 ml of M9 buffer to the tube. Place the tube 
on a rocker at 20 °C overnight, and allow the embryos to hatch.

Mount worms on an agar pad ● TIMING 20 min
5 | Add 50 µl of anesthesia solution into the small well of the three-well glass slide (detailed example of Steps 5–9  
in Supplementary Video 3).

6 | Flame a worm pick until it glows orange, and allow it to cool for 2 s. Then, using a glob of OP50 E. coli from a  
fresh plate, pick up worms of interest, using a dissecting stereomicroscope. Gently swirl the pick in the 50-µl  
anesthetic (dispensed with a P200 pipette) in the glass spot plate (Fig. 3a and Supplementary Video 3). The surface  
tension of the liquid anesthetic will pull the glob of bacteria and worms off of the pick. Transfer 20–30 worms in total.  
If possible, try to collect all desired worms in one round of picking, to ensure that all worms are in the anesthetic for an 
equal amount of time.
 CRITICAL STEP Minimize the amount of OP50 bacteria transferred along with worms into the anesthesia solution.  
Large amounts of bacteria in the anesthesia solution may decrease worm viability during time-lapse imaging.

7 | Wait 12 min to allow worms to be anesthetized. Perform Step 8 during the incubation period.

8 | Prepare an agar pad by placing a clean microscope slide between the two guide slides, each of which has two  
pieces of laboratory tape applied on top of each other (i.e., two pieces thick) (Fig. 3b). Next, pour a drop (~500 µl) of 
molten 5% (wt/vol) noble agar in the middle of the clean slide. Quickly place a second clean slide on top of the drop of 
agar, and then press down firmly on the ends of the top slide that overlap the taped guide slides (Fig. 3b). Allow this 
setup to sit until the end of the incubation in Step 7.
 CRITICAL STEP Agar pads must be freshly made to prevent drying out during imaging. It is better to pour an agar pad that 
is too large, which can then be trimmed down with a razor blade to the size of the 22 × 22 mm coverslip (Fig. 3d). Agar can 
be cleaned off the razor blade by using laboratory wipes. Maximizing the pad size allows for placement of more worms  
(n > 20) on each slide. Even with synchronization, it can be difficult to find worms at the exact developmental  
stage desired.
  An agar pad that is too small will leave large spaces of air after VALAP is applied and thus can cause the pad to dry  
out more quickly.
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9 | Using a mouth pipette, transfer worms (in the liquid anesthetic) onto the trimmed agar pad (Fig. 3e). With the same 
mouth pipette used to transfer the worms, remove excess liquid. Cover the worms with a standard glass coverslip, starting  
at one side and gently dropping the coverslip across the agar pad to avoid air bubbles.
! CAUTION Always use caution when using a mouth pipette to avoid ingesting any fluid.
? TROUBLESHOOTING

10 | Seal the coverslip with VALAP to minimize liquid evaporation (Fig. 3f).
 CRITICAL STEP Use a small paintbrush to apply VALAP to four sides of the coverslip, and leave a small gap for gas 
exchange at two sides. With a razor blade, remove the residual VALAP high above the coverslip’s upper surface to minimize 
the risk of getting VALAP on the microscope objective.
? TROUBLESHOOTING

Time-lapse imaging ● TIMING 20–180 min
11 | Turn on and configure the confocal imaging system.
 CRITICAL STEP Before you begin, you will need to determine the appropriate settings for some key image- 
acquisition parameters. These will depend on your individual specimen and the dynamics of what you are trying to capture 
(Supplementary Video 4). Below are two examples of specific image acquisition and the appropriate settings on our systems:
  Capturing invadopodia dynamics at the AC–BM interface (ventral view).
    Markers: AC-specific mCh::moeABD (marking F-actin), LAM-1::GFP (labeling laminin in the BM) and a dominant rol-6 

mutation (urIs[rol-6(su1006); lam-1>lam-1::GFP]), which causes worms to roll and results in ~20% of mounted worms 
being oriented with their ventral sides toward the microscope objective (Fig. 4b).

    Microscope: Spinning-disk confocal microscope (Fig. 4a)
    Camera: Hamamatsu EM-CCD
    Laser power: 100% for 25-mW, 488-nm and 25-mW, 561-nm laser lines
    Exposure: 50 ms (488 nm, LAM-1::GFP) and 100 ms (561 nm, mCh::moeABD)
    EM Gain: 220 (maximum is 255)
    Gain: 0
    Binning: 1 × 1
    z-step size: 0.5 µm
    Total number of steps: 8 (covering 3.5 µm at 0.5-µm z steps)
    Time intervals: 15 s
    Time-lapse duration: 30 min
  Imaging invasive protrusion dynamics during BM transmigration (lateral view).
  Markers: AC-specific mCh::PLCδPH (PI(4,5)P2 probe in the AC) and LAM-1::GFP (labeling laminin in the BM).
  Microscope: Spinning-disk confocal microscope (Fig. 4a)
  Software: iVision
  Camera: Hamamatsu R2

  Laser power: 85% for 20-mW, 488-nm and 25-mW, 561-nm laser lines
  Filters: Filterwheel with ZET448/561nm and ZET405/448/561
  Exposure: 100 ms (488 nm, LAM-1::GFP), 200 ms (561 nm, mCh::PLCδPH)
  Gain: 0
  Binning: 2 × 2
  z-step size: 1 µm
  Total number of steps: 7 (covering 6 µm at 1 µm z steps)
  Time intervals: 60 s
  Time-lapse duration: 90 min
 CRITICAL STEP Use the same settings for quantitative measurements. Set the exposure time and laser intensity to ensure 
proper image quality, but without photobleaching. Minimize EM gain for an EM-CCD camera to achieve high signal-to-noise ratios. 
Settings must be optimized in iVision (or other time-lapse aquisition programs) according to different experimental contexts.

12 | Place the slide with the immobilized worms on the stage of a spinning-disk confocal microscope.

13 | Identify healthy L3 larvae on the basis of their sizes under a 10× objective lens by using a compound microscope  
(we use a Zeiss Axioimager.A1).
 CRITICAL STEP It is important to select healthy worms for imaging. Avoid imaging worms with lysed cells (apparent by clear 
regions) in the head or body. Also avoid imaging worms that are not in the standard lateral- or ventral-view position, because 
nonstandard orientations can cause difficulty in data analysis after 2D or 3D reconstruction with ImageJ or Imaris, respectively.
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14 | Determine the developmental stage with respect to the number of primary vulval cells (P6.p one-, two- or four-cell 
stage; Supplementary Fig. 1 and Supplementary Table 1) by using a compound microscope (Zeiss Axioimager.A1) and a 
100× oil-immersion objective lens and immersion oil. Choose P6.p two-cell-stage worms for time-lapse imaging, because 
wild-type ACs initiate BM breaching at this stage (~30 h after hatching when grown at 20 °C).
? TROUBLESHOOTING

15| Start time-lapse imaging and readjust the focus plane during the imaging process if using a microscope with manual 
focus adjustment.
 CRITICAL STEP Correction for drift in the z axis (axial movements, which may result from slight drying of the agar pad  
drying or from worms settling into the agar) will need to be performed routinely every 5 min for the first 20 min of the  
time-lapse imaging. After 20 min, this z drift usually stabilizes. Correction for this drift can be done between time points  
by manually adjusting the z position of the microscope stage to keep the AC within the limits of the set z stack, without 
needing to pause the acquisition or adjust the stage piezo. Minor movements of the worms in the x and y axes (planar  
movements) can be corrected for later during image analysis (described in Image Analysis below below).
? TROUBLESHOOTING

16 | End image acquisition and save files. We typically save acquired images as .TIFF or .IPM (iVision format) files,  
which are accessible by a wide variety of software.
 PAUSE POINT You can proceed to data analysis at the time of your choosing.

Importing and visualizing 4D data in Imaris ● TIMING 20 min
17 | Open the original time-series data set in Imaris. Ensure that the specifications for the x, y and z dimensions are correct. 
(At this step x, y and z should each have a value of one. These are not the voxel dimensions; additional information is  
provided below.) Also ensure that the number of time points (T) and the number of channels (C) of the data set are correct 
(by selecting File→Open…→Settings…→File Names without Delimiter) (detailed video of Steps 13–18 in Supplementary Video 5).
? TROUBLESHOOTING

18 | Adjust the voxel dimensions. Ideally, this information will be contained within the metadata of your files and will  
not need to be manually entered.
 CRITICAL STEP The geometry size of a pixel and the image binning should match the image-acquisition settings.  
The pixel size of our imaging system is 0.062 µm × 0.062 µm or 0.15 µm × 0.15 µm when binning is set to 1 × 1 on the left 
and right imaging systems shown in Figure 4, respectively. If the z-stack distance interval is set to 0.5 µm, the voxel  
size is then 0.062 × 0.062 × 0.5 µm3. A stage micrometer should be used to independently verify the calculated voxel  
dimensions. You should be suspicious if the x, y and z voxel dimensions of the imported data are 1 µm × 1 µm × 1 µm or  
proportionately 1:1:1.
? TROUBLESHOOTING

19 | Adjust the intensity levels and pseudocolor channels as appropriate (Edit Show Display Adjustments).

20 | Use the Spot tool in Imaris to correct the natural drift that occurs over the course of the time lapse (Supplementary 
Video 5). To do this, click the Spots icon in Imaris. Select Segment Only a Region of Interest, deselect Process Entire Image 
Finally, and click the Next icon.

21 | Set the region of interest (ROI) to include all of the x and y axes, but only a single plane in the z axis, and  
select Next.

22 | Select the channel that includes the AC-marker fluorescence, set the Estimated Diameter to 10 µm, and then click Next 
twice. Choose the algorithm Connected Components; click Next, and then click the Finish icon. Select the entire track over 
time, and choose Correct Drift→Include Entire Result→OK.

23 | Crop the volume in 3D to include only the information needed for analysis (Edit→Crop 3D…). This procedure will  
decrease the file size.
 CRITICAL STEP Depending on the object(s) that you are trying to measure, you may need to re-align the data set such  
that the x, y and z axes of the camera square up with the anterior–posterior, dorsal–ventral and left–right axes of the worm 
(Fig. 4b). This re-alignment facilitates partitioning of cellular domains for analysis (e.g., the AC invasive cell membrane)  
and can be done with the Free Rotate function in Imaris (Image Processing→Free Rotate…) (Fig. 5a).
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24 | Save the data set as a new file (as an .IMS file in Imaris) to serve as the working data set for subsequent analyses  
(File→Save as…→.IMS). For presentation or publication purposes, videos can be generated to display particular aspects  
of your data set (View→Animation). Within Imaris, you may also capture snapshots of a 3D volume from multiple perspec-
tives (View→Snapshot) (Fig. 5b).

Quantifying the spatiotemporal dynamics of AC invasion ● TIMING variable
25 | Use option A to open a ventral-view data set containing an invadopodia marker, and use the Spot function in  
Imaris to quantify AC-invadopodia dynamics (Fig. 6; Supplementary Video 6). Use option B to measure invasive protrusion 
volume with isosurfaces (Fig. 7; Supplementary Video 7). Use option C to quantify the rate of BM-hole expansion  
(Fig. 8; Supplementary Video 8).
(A) Using the Spot function in Imaris to quantify AC-invadopodia dynamics
	 (i) �Click the Surfaces icon. Deselect Smooth, and click Next. Set a threshold that accurately reflects the invadopodia  

to be measured, and click Next. Take note of the threshold value for future reference, click Next three times,  
and then click Finish.

	 (ii) �Click the Add New Spots icon. Make sure that Segment Only a Region of Interest is deselected before clicking Next. 
Deselect Background Subtraction, and enter ‘0.5’ in the box labeled Estimated Diameter, then click Next. Set the  
filter type to Intensity Mean Ch-1, and enter the intensity threshold noted in (A) above. Click Next twice. Choose  
Autoregressive Motion in the Algorithm options. Under Parameters, enter ‘0.5’ as the Max Distance and ‘0’ as the  
Max Gap Score. Click Next. Select and delete the default track. Click Finish. 
 CRITICAL STEP At 15-s intervals, we allow a drift distance of 0.7 µm and use a frame gap of 0. According to our 
criteria, objects must be present in at least two consecutive frames to be identified as AC invadopodia (spots that 
disappear and then reappear will be counted as new AC invadopodia; Fig. 6c). Although the software programs do a 
reasonable job in generating tracks by connecting spots in consecutive frames, you will need to verify that tracks  
are properly assigned. To do so, you will need to manually edit individual tracks, a time-consuming process that  
limits the number of animals that can be examined.

	 (iii) �Click the Statistics Tool icon to see data values resulting from the analysis. Click the Save icon to export the statistical 
data to an Excel file.

	 (iv) �Determine descriptive data for the following AC-invadopodia dynamics by using the exported numbers (Fig. 6d).  
For invadopodia size, individual invadopodia sizes (in micrometers; Fig. 6a) are listed in the Diameter tab in the  
Excel spreadsheet. For invadopodia lifetimes, refer to the Track Duration values, which represent the number of time 
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Figure 5 | Re-alignment by free rotation and use of the Snapshot tool in Imaris. (a) Images show lateral view of a 3D reconstruction of the AC (cyan) as it 
invades through the BM (magenta). Before free rotation (leftmost image), the anterior–posterior (A–P) and dorsal–ventral (D–V) axes of the AC do not line up 
with the x and y axes of the camera (white-lined grid). After free rotation, however, the AC and the camera area align. After re-alignment, a custom ROI (which 
can be drawn only within the axes of the camera) can be used to generate an isosurface (Image Analysis, Step 2.2) in place of the portion of the AC that has 
extended through the BM. (b) Images of a 3D reconstruction, captured from multiple perspectives with the Snapshot tool in Imaris. Scale bars, 5 µm.
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points for which an invadopodium persisted. This number must be multiplied by the duration of each time point to  
obtain an actual value in minutes. In wild-type animals, the number of AC invadopodia during the hour before  
invasion does not appear to significantly change over time. To determine the average rate of invadopodia formation, 
divide the values in Number of Tracks by the duration of the time lapse. For example, if 100 AC-invadopodia tracks are 
detected in a 20-min time lapse, then the average rate of AC-invadopodia formation for that animal is 100/20 = 5 AC 
invadopodia per minute. For invadopodia numbers over time, use the values listed as Number of Spots per Time Point. 
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highlighted 4-min window. Each track represents the lifetime of a single AC invadopodium. (d) Graphs display quantitative measurements of wild-type AC 
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(B) Measure invasive protrusion volume with  
isosurfaces in Imaris
	 (i) �Open a lateral-view Imaris file containing  

a fluorescent marker that labels the cell-membrane  
protrusion (Table 1 and Supplementary Table 2).

	 (ii) �Click the New Isosurface icon. Deselect the box Process Entire Image Finally, and click Next. Adjust the ROI box  
so that it includes only the area beneath the AC directly adjacent to the uterine–vulval BM (example in Fig. 5a).  
Click Next twice. Select a Threshold value that closely fits the volume of the protrusion over the entire time course. 
Document the Threshold value, click Next twice, and then click Finish. Click the Statistics tab to export data for the 
volume of the protrusion at each time point to an Excel file. 
 CRITICAL STEP Apply the same threshold to generate isosurfaces for comparison. Use the Cut Surface function  
for spatial segmentation of an isosurface. There may be instances (e.g., a curved BM or a fluorescence intensity  
too variable for proper thresholding) in which you need to manually outline the protrusion in each frame instead of  
using the ROI tool. After clicking the New Isosurface icon, click Skip Automatic Creation, Edit Manually. Then use  
the Paintbrush tool to outline the surfaces to be include in the analysis for each frame, and click Finish.

(C) Quantify the rate of BM-hole expansion in ImageJ
	 (i) �Import an Imaris file for a worm expressing a BM marker imaged from the ventral perspective that has been  

drift-corrected and re-aligned by free rotation to display the BM from a head-on perspective (Steps 20–23 and  
Fig. 5b, right). This step and the following steps are also shown in Supplementary Video 8.

	 (ii) �Export a movie (.MOV) or .TIFF series (as maximum image projections) in Imaris, and then open the file in ImageJ. 
 CRITICAL STEP Include a scale bar in the movie exported from Imaris, which will allow you to convert the data  
from an area in pixels to an area in square micrometers. Use the Straight (line) tool to draw a line along the scale  
bar, and note the number of pixels that correspond to the number of micrometers in the error bar. This information 
 will be necessary in (G) below.

	 (iii) �Use the Rectangular Selection tool in ImageJ to select an ROI that excludes the black margins outlining the  
video data, and select Image→Crop.

	 (iv) �Adjust the threshold (Image→Adjust→Threshold) until the BM gap is precisely fitted during the duration of the movie. 
Click Apply and OK to create a binary image.

	 (v) �Select Analyze→Analyze Particles. Input ‘3000-Infinity’ in the Size option, select Outlines in the Show option,  
and click OK. Click Yes at the ‘Process all… images’ prompt.

	 (vi) �Copy the results, and paste these data into an Excel file. Exclude any outlines that do not correspond to the  
area of hole opening).

	 (vii) �Calculate the area of BM removal at each time point with the following formula: 

BM Removed m Area value m of error bar/pixels width of error b( ) (m m2 = × aar)2

? TROUBLESHOOTING
Troubleshooting advice can be found in Table 2.
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● TIMING
Steps 1–4, synchronizing worm cultures for imaging: 15 min
Steps 5–10, mounting worms on agar pad: 20 min
Steps 11–16, image acquisition: 20–180 min
Steps 17–24, image processing: 20 min
Step 25, quantifying invasion dynamic and data analysis: variable

ANTICIPATED RESULTS
Our time-lapse protocol allows for imaging of the cell-invasion process through BM at single-cell resolution in living  
animals. By analyzing the data resulting from the images captured, quantitative in vivo traits can be determined for  
invadopodia dynamics, plasma-membrane protrusion volume and BM removal. 4D data analysis of marker proteins for  
subcellular structures of interest, such as F-actin-based invadopodia, can reveal the spatial and temporal features of these 
structures during AC invasion, including the turnover rate, lifetime and dynamic localization. Through this protocol, we have 

Table 2 | Troubleshooting table.

Step Problem Possible reason Solution

9 There are too many  
bubbles around worms

Too little anesthetic liquid is left on  
the slide

Stop removing anesthetic with the mouth pipette  
after the liquid no longer easily fills the capillary glass 
without application of suction

Worms are too widely  
distributed on the  
agarose pad

Too much anesthetic liquid is left on 
the pad

Try to minimize the amount of liquid transferred with 
the worms by gently tapping the glass spot plate  
(the worms will coalesce at the bottom of the well  
(Fig. 3c), thus allowing you to draw them up in a  
minimal amount of liquid)

10 Worms become sick or  
die during imaging

Too much OP50 is transferred with 
worms 
Worms are injured while they are  
anesthetized, transferred and covered 
by the coverslip 
The interface between the coverslip and 
the agarose pad is not properly sealed

Use a minimal amount of bacteria to transfer worms  

Use care when handling worms at all points  
 

Use a small paintbrush to apply VALAP to four sides of 
the coverslip, and leave a small gap for gas exchange

14 Worms are not at the  
correct stage in  
development to image

Animals of the wrong size are picked  

Worms are cultured for too little or too 
much time after synchronization 
Worms are not kept at an optimal  
temperature

Synchronize animals by bleaching instead of trying to 
pick them from plates containing mixed-age worms 
Optimize the correct incubation time and temperature 
for each strain

15 Specimens with low  
fluorescence signal result 
in grainy images

EM gain might be too high, whereas 
exposure time is probably too short

Adjust the settings until high-quality images are 
acquired

Worms start moving  
during time lapse

Worms are too crowded, or the  
incubation in anesthetic is too short

Lengthen incubation time in anesthetic, and avoid  
using mounted worms that are touching each other, 
because they tend to move more during time lapses

Photobleaching occurs  
during imaging

Worms are exposed to too much  
cumulative laser power

Decrease laser power and exposure time

17 Imaging data cannot  
be loaded into Imaris

The format of data files is not properly 
selected in Imaris

Try to correctly match the file format selected in  
Imaris with that of the raw data files

18 Disproportionate  
3D rendering occurs

Geometry set in Imaris does not match 
acquired raw images

Verify that the voxel dimensions are correct 
If voxel size was determined by calculation, confirm 
with a stage micrometer
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consistently measured AC-invadopodia dynamics in wild-type worms and have successfully characterized the roles of proteins 
that regulate invadopodia dynamics through genetic-mutant and RNA-interference knockdown studies. These proteins  
include several cytoskeletal proteins, such as the F-actin-severing protein cofilin, which promotes invadopodial turnover;  
the Rho GTPase Cdc42, which initiates the seeding of new invadopodia; and the Rab dissociation inhibitor GDI-1, which 
targets the endolysosome-derived invadopodial membrane to the invasive cell membrane and facilitates formation of  
invadopodia15,18 (Fig. 6; Table 1). In addition, this protocol has the sensitivity to identify changes in the volume of the 
invasive protrusion that follows formation of invadopodia (Fig. 7). We have identified the netrin receptor UNC-40 (homolog 
of vertebrate DCC) as a key receptor that traffics to the BM breach site and directs the creation of the invasive protrusion 
through its F-actin-regulatory effectors UNC-34 (Ena/VASP) and MIG-2 (RhoG)47,48. Finally, the range, shape and size, and 
the dynamic patterns of BM removal can be precisely measured by following the steps outlined above16,46,49,57 (Fig. 8).  
Using these methods, we have identified several proteins that regulate BM clearing under the AC, including hemicentin,  
a conserved extracellular member of the immunoglobulin superfamily, which physically links the two juxtaposed BMs under 
the AC, thereby optimizing BM breaching and hole opening49. In addition, we have found that overexpression of SPARC,  
a matricellular protein that is upregulated in many if not most metastatic cancers, promotes AC invasion by perturbing  
deposition of type IV collagen, thus thinning the BM16. In summary, this protocol can be coupled with a multiplicity  
of combinations of fluorescently tagged proteins, varying genetic backgrounds and conditions (such as pharmaceutical  
treatment and starvation) to uncover the molecular and cellular mechanisms that drive the invasion process in vivo in  
both development and disease states such as cancer.

Note: Any Supplementary Information and Source Data files are available in the 
online version of the paper.
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